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1750 Power Recorder

Introduction

The Fluke 1750 Power Recorder is a comprehensive yet easy to use system for
power quality investigations. The 1750 Power Recorder, referred to hereafter
as simply “the Recorder”, consists of a power recorder instrument, a wireless
handheld Personal Digital Assistant (PDA) for control and setup, and a
powerful yet easy to use PC application, Power Analyze. Four 400 A current
probes are provided as standard equipment (not included in Basic version). A
wide range of flexible and clamp-on current probes are available from Fluke.

Key features of the 1750 Power Recorder are:

No PC needed for setup

Using the included wireless-enabled Personal Digital Assistant (PDA)
as a controller, you do not need a PC to configure the Recorder,
troubleshoot connections, preview data, or download the recorded
data. Downloaded data goes onto the SD memory card plugged into
the 1750, not directly to the PDA. The range of the PDA with the
wireless link is about 15 meters (45 feet) from the Recorder.

Simplified test lead connections to the power network

Simply connect a voltage probe to a conductor on each phase that you
want to record. On the current inputs, the Recorder automatically
identifies what type of probe is connected. The Recorder then
configures its measurement system appropriately for the model of
current probe you are using.

Connection diagrams for the supported power network configurations
(delta, Wye, and others) appear on the handheld PDA controller.

Once you make connections, you can view live readings and a phasor
diagram on the PDA to confirm the connections. If a phase channel is
wired incorrectly, you can swap the phase to another channel by
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changing an internal Recorder setting using the PDA, and then
reconfirm correct readings.

e Internal Uninterruptible Power Supply (UPS)

An internal NiMH (Nickel-Metal-Hydride) battery pack and charging
system maintain data capture continuity through power interruptions
of approximately 8 minutes or less.

e Automatic disturbance capture

The Recorder uses an automatic, self-learning threshold routine,
which means you do not have to set any event threshold limits before
you start recording. You detect and display power quality events
(disturbances) using the Power Analyze software on a PC after the
event has been captured. You define thresholds for events after data is
stored on the PC. This is called the "event detector" in the software. It
does not make permanent changes to the data file, so you can
experiment with different thresholds after the fact without worrying
about losing data.

With these features, there is little else required to set up and start recording the
data to conduct a power quality survey. Should you want to extensively
analyze collected data, the procedures described later in this manual review the
transfer of data from the Recorder to the PDA, and finally to a PC. Data may
then be analyzed using Power Analyze on a PC. Extensive online help is
provided in the Power Analyze software on the product CD shipped with the
Recorder.

Contacting Fluke
To contact Fluke, call one of the following telephone numbers:
e  Technical Support USA: 1-800-44-FLUKE (1-800-443-5853)
e (Calibration/Repair USA: 1-888-99-FLUKE (1-888-993-5853)
e (Canada: 1-800-36-FLUKE (1-800-363-5853)
e Europe: +31 402-675-200
e Japan: +81-3-3434-0181
e Singapore: +65-738-5655
e Anywhere in the world: +1-425-446-5500
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Or, visit Fluke's website at www.fluke.com.

To register your product, visit http://register.fluke.com.

To view, print, or download the latest manual supplement, visit
http://us.fluke.com/usen/support/manuals.

To contact Technical Support: fpgsupport@fluke.com or 888-257-9897

Safety Information

See the Specifications section of the Operators Manual for a full agency
compliance list. Table 1 lists symbols that appear on the Recorder and in this

manual.

A AWarning

To avoid electrical shock or fire:

Review the entire manual before using the
Recorder and its accessories and observe all
warnings and cautions.

Avoid working alone.

Do not operate the Recorder around explosive gas
or vapor.

Use only insulated current probes, test leads, and
adapters as supplied with the Recorder.

Before use, inspect the Recorder, voltage probes,
current probes, leads, and accessories for
mechanical damage, and replace when damaged.
Look for cracks or missing plastic. Pay special
attention to the insulation surrounding the
connectors.

Remove all probes, test leads, and accessories that
are not in use.

Make sure the Recorder is properly connected
through the power cord to protective earth ground.

Do not apply input voltages above the rating of the
Recorder as shown on the input panel.
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Do not apply voltages in excess of the marked
ratings of the voltage probes and current probes.

Do not use exposed metal BNC or banana plug

connectors.

Do not insert metal objects into connectors.

Table 1. Symbols

Symbol

Description

Symbol

Description

Hazardous voltage. Risk of
electrical shock. Precedes
Warning

A

Risk of danger. Important
information. See manual.
Precedes Caution and
Warning.

Conforms to requirements
of European Union and
European Free Trade
Association (EFTA).

I3

Do not dispose of this
product as unsorted
municipal waste. Contact
Fluke or a qualified recycler
for disposal.

Canadian Standards

distribution panels, feeders
and short branch circuits,
and lighting systems in
large buildings.

@f’s Association. [ Note: L Frotgctl;/ & conductor
Canadian and US. ] erminal.
CAT Il equipment is
designed to protect against CAT IV equipment is
transients in equipment in designed to protect against
fixed-equipment transients from the primary
CAT Ill | installations, such as CAT IV | supply level, such as an

electricity meter or an
overhead or underground
utility service.
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Standard Accessories

Table 2 describes the standard accessories that ship with the Recorder. Other
optional accessories are also available. See the 1750 Operators Manual for a
complete list.

Table 2. Standard Accessories

Description Part Number
Ethernet cable, 3 meters, yellow 2402854
Colored plastic clips for test leads (32 clips, 8 colors, 4 clips 2157607
each color)
Model TLS430, test lead set including cable and clips 2157713
512 MB Secure Digital (SD) Memory Card for downloading 2386744
data
Model 3140R, 400 A Probes (4 - not included with Basic 2277216
version)
AC power cord, 3 meters 2441360
Personal Digital Assistant (PDA) with docking station 2386780
CD ROM Manuals and Software 2386771
1750 Getting Started Guide 2386767
Sheet of Front Panel Decals 2436261
Sets of international ac power plug adapters for the PDA 2583479
charger
International adapters for the Recorder power cord 2441372
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Features
The Recorder front panel is illustrated in Figure 1 and described in Table 3.

azd09f.eps

Figure 1. Fluke 1750 Power Recorder
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Table 3. Input Terminals and Controls

Number

Description

Standard 120/240 V 50/60 Hz power input for Recorder power

Voltage indicator
Steady Voltage is present, not overloaded
Blinking Voltage overload (overload threshold 1100 V)

Five voltage measurement inputs

Removable Secure Digital (SD) memory card for transfer of large
quantities of data. You can remove the card from the Recorder,
insert in the PDA and transfer data to the PC via the “synchronize
data” feature of the PDA. A USB SD card reader may also be used.

SD status indicator
Steady green  SD card inserted
Blinking Busy - do not remove the card

Wireless Controller Status Indicator

Steady Blue  Wireless controller enabled but not communicating
Blinking Wireless controller communicating or other activity
Off Disabled

Ethernet port. TCP/IP via Ethernet is used to connect the Recorder
to a PC for downloading recorded data, and for configuring the
Recorder when not using the PDA. This is the recommended
method of data transfer due to its speed and reliability.

Busy Indicator
Blinking Network is busy

Link indicator

Off No link

Steady Link Present

Blinking Communicating (with PDA or PC)

Current Measurement Terminals (5)
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Table 3. Input Terminals and Controls (cont.)

Number Description
D) Current indicator
Steady Current probe in normal range
Blinking >110 % of probe range, use a higher range
probe
Off Current insufficient to measure
B Red/Green LED
Steady green AC input power normal

Green/Orange blinking  Recording

Blinking red Recorder running on UPS

(E) Ground Terminal

Connecting the supplemental ground terminal and the line cord
safety ground to different ground potentials creates a ground loop
that can damage the Recorder. To avoid this, use the
supplemental ground terminal only when no protective earth
ground connection exists through the line power cord. If there is
any chance that a safety ground connection does exist through
the line power cord connection, make sure to connect the
supplemental ground terminal only to the ground system used by
the ac receptacle that powers the Recorder. See Figure 2.

205 Westwood Ave
Long Branch, NJ 07740
1-877-742-TEST (8378)

Fax: (732) 222-7088
salesteam@Tequipment.NET

equipment
CANPRET



dada
Long TEQUIPMENT

http://www.tequipment.net

1750 Power Recorder
Features

A Caution

Connecting the supplemental ground terminal and the line
cord safety ground to different ground potentials creates a
ground loop that can damage the Recorder.

See A Caution Above

Optional Measurement
Ground 2 M Input Impedance
(OK to connect to any ground.)

Potential Optional Protective
Ground Chassis Ground
Loop (See detail below)
Different Power System Power Network Being Measured

Line Power Cord

§ ;

ac

e

. Correct,

= No Ground Loop @ GND =

Incorrect,
Creates Ground Loop

azd11f.eps
Figure 2. Connecting the Supplemental Ground Terminal
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Charging the PDA Battery

Your PDA is shipped with a discharged or partially charged, rechargeable
battery. You should fully charge the battery before setting up the device, and
recharge it regularly. Refer to your PDA user’s guide for detailed information
about the battery.

A Caution

Do not leave important data on the PDA. If the battery
discharges completely, you will lose all data not stored in
File Store (ROM). Discharging the battery completely is
similar to performing a hard reset. Refer to the PDA user’s
manual for more information.

Installing the Software

This section describes how to install Fluke Power View software on the PDA
and Fluke Power Analyze software on your PC. Keep your product CD in case
you need to reinstall this software in the future. You should periodically check
the Fluke website: www.fluke.com to see if any 1750 firmware or application
software updates are available for download. Fluke encourages you to register
the Recorder. After your Recorder has been registered, you will receive email
notifications of firmware and software update availability.

Installing Power View on the PDA

1. Insert in your PC the CD that ships with your PDA. Follow the on-
screen instructions to install the ActiveSync software for Windows
XP (or Mobile Device Center for Windows Vista and Windows 7)
that allows your PC to communicate with the PDA.

2. Put the PDA in the docking station and establish a partnership
between the PDA and your PC. Keep your product CD in case you
need to reinstall this software in the future.

3. Insert the CD that ships with your Recorder in the CD-ROM drive on
your PC.

4. A window appears that lists options on the CD. If the install software
window does not automatically appear, do the following:

a. On the Windows taskbar, select Start, then Run.

10
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Installing the Software

b. Type d:\sw\PowerViewInstall.exe (where d: is your CD

drive letter).

5. Select Install Software.

6. Select Install Fluke Power View.

Power View will be installed in the Programs folder on the PDA.

7. To start Power View, select Start, and then Programs on the PDA.

FLUKE.

8. Tap the Power View icon () to start using the application.

Language Selection

Power View features a localized user interface for English, German, French,
Spanish, Chinese, and Italian. To choose a desired language, select
Menu\1750 Setup\Language and select a language from the list.

¥y
‘w

Power Yiew

o dqé1:ss €

1750 SETUP
oy
Clock Probe Detect IP Address
Nominal Recorder Phase
Power MName/Password Swap
Yolts/Current  Snapshot Laguage
Ratio Period
Live Menu [0} B} <& @ El;

Setup Screen with language.bmp

11
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PC System Requirement for Power Analyze

Windows 2000 Professional at minimum, Windows XP or higher
recommended. Administrator privileges are required to install
applications.

PC with 300 MHz or higher processor clock speed, Intel
Pentium/Celeron family, or AMD Athlon/Duron family, or better.

Processor Recommended: 1 GHz or higher, Pentium 4, AMD Athlon,
or better.

256 MB RAM (1 GB recommended).
1024 x 768 or higher resolution video.

Keyboard and mouse.

Installing Power Analyze

Before installing the software on your PC, make sure you have Internet
Explorer version 6, or later appropriate to the language or culture settings of
the operating system installed on your computer.

A Caution

Do not remove the CD until after you have successfully
installed the software, rebooted the machine, and opened
the application.

1.
2.

12

Insert the CD into your CD-ROM drive.

A window appears that lists options on the CD. If the window does
not automatically appear:

a. Use Windows Explorer to locate the “sw/FPAlnstall.exe” file on
the CD.

b. Double-click “FPAlnstall.exe” to launch the installation program.
Select Install Software.
Select Install Fluke Power Analyze.

Follow the installation instructions that appear. After software

sssss

desktop.
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Installing the Power Recorder at a Facility

6. Start Power Analyze on your PC by choosing Start >All Programs
>Fluke >Power Analyze >Launch Power Analyze or double-click
the Power Analyze icon [@] on your desktop.

After the installation is complete, please take a few minutes to complete your
product registration. You can register quickly online (preferred) at
http://register.fluke.com or you can print the form and fax it to the number
provided on the form. Product registration is very important since it allows you
to get free software updates and helps us provide you with the fastest and most
efficient technical support.

Note

You may need to change your Windows firewall settings to allow the
program FPA.exe to use ports 18571 (TCP) and 18572 (UDP). For
more on changing firewall settings, refer to
http://support.microsoft.com.

Installing the Power Recorder at a Facility

This section describes the steps you need to take to set up the Recorder at a
facility and begin a recording session.

Work Flow
There are three distinct stages for a recording session.
e Set-up

Set-up, hookup, and verification of connections and measured signals.
This is when you will want to clear the Recorder memory (not
required, but good practice because data download when finished
only contains your new data), make any desired Recorder setting
changes, and insert annotations and/or an optional Start mark into the
recorded data stream. Annotations are messages or notes you insert
into the data stream during a recording session.

e Interim checkup, mid-recording session (optional)

At this time, you may want to re-check all the live input signals, and
download the data recorded since the beginning of the recording
session. This does not interfere with ongoing recording in any way.

13
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Annotation capability is always available during the recording
session.

e End of recording session

You can re-verify if desired, correctness of live data and then
download data, power off the Recorder, and pack up for transport.

Installing the Recorder
To install the Recorder at a facility, follow the basic steps below.
1. Position the Recorder within 2 m (6 ft) of the monitoring location.

2. The Recorder can be set on the floor or a table, or attached and
secured to a pole or other mounting surface. The Recorder can be
oriented vertically or horizontally.

3. Connect the Recorder to a 100 to 240 V ac power source, 50 or 60
Hz.
A\ Caution
To avoide damage to the Recorder:

¢ Ground the chassis before you do anything else.

e Connect the power cord to the Recorder using the
appropriate supplied adapter.

e Connect the power cord to a properly grounded wall
outlet.

e Be sure to plug the power cord into the Recorder panel
BEFORE connecting it to an outlet.

4. Plug the power cord into a properly grounded wall outlet.

5. All LEDs should flash ON, then OFF, and then each should turn ON
and OFF in sequence. The LEDs will then remain on if you make
secure test lead connections and there is sufficient voltage and
current.

FLUKE.

6. Turn on the PDA and tap the Power View icon &2 to launch Power

View.

14
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Installing the Power Recorder at a Facility

If a Recorder is within range and is not password protected, it should
appear in the drop down menu just below the main title bar on the
PDA. Select the recorder you want to browse to with the PDA stylus.
Upon selection, the Home screen for live data appears.

If more than one Recorder is within range, these will appear in the
drop down menu list.

7. If you have previously established password protection for the
Recorder using the Power Analyze PC software, you must type the
correct password in the Password text box and tap the Enter button.
(Password protection is established for a specific Recorder using
either the Setup Password menu in Power View or the Power Analyze
software).

Connecting the Recorder to the Wiring

After you have set up the Recorder you are ready to connect the voltage leads
and current probe or flexi-probes to the power network being tested. Refer to
the Power Type diagrams provided on the PDA or in the 1750 Operators
Manual.

A AWarning

To avoid electric shock, Flexi-probes should not be
applied or removed from hazardous live conductors.

In most cases, you should install the current probes first. Because they are
clamped around wires, current probes are usually more secure than voltage
probes. Examine the conductors you are about to connect to and determine if
you should attach the current probes to the phase wires or busbars before you
connect the voltage probes.

1. Select and attach the appropriate current probes to the Recorder.
2. Select and attach the appropriate voltage test leads and probes to the
Recorder.
Note

If your power connections require potential transformers (PTs) or
current transformers (CTs), you can use the ratio settings in Power
View to set the Recorder to display readings as they exist on the
primary side of the PT and CT (for example, 12000 V).

15
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Connect the Recorder to the wiring by first connecting the
measurement ground test lead to the distribution system ground, and
then the neutral probe to neutral.

Connect the ground clamp to the distribution system ground and the
neutral clamp to neutral, with the arrow on the current probe pointing
towards the load (away from the source) in each case.

Connect the remaining current probes to the power network.
e The arrow on the clamp should point toward the load.

e  Use the color-coding on the leads to help you connect the probes
to the correct phases, neutral and ground.

Connect the remaining voltage probes.

Note

Make sure the voltage probes and current probes are paired correctly, Phase
A (L1) voltage to Phase A (L1) current and so forth. Calculations are made in
pairs and cannot be changed after data is recorded. The leads for the voltage
probe and current clamp of the same color should be attached to the same
phase wire or busbar.

7.

Check the LED for each phase to make sure a connection is
established.

e When a phase LED is ON or lighted, you know that the
connection is active and that voltage and current is within the
normal range.

e  When a phase LED is BLINKING, you are connected but the
voltage or current is exceeding the normal range or exceeding the
range of the probe that you are using.

e  When a current LED is OFF or unlit, there is insufficient current
present in the line.

Verifying Your Connection

Before you leave the Recorder to accumulate data at the facility, double-check
the connections.

16

Make sure the current probes are secured and completely closed
around the conductors and that the voltage and current LEDs are
steady-on.
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e  Use the PHASOR screen on the PDA or PC to verify that the voltage
and current connections are correct. You can swap the connections
using Power View if they are incorrect.

Finishing UP

After making any corrections to the connections, recheck the PHASOR
diagrams to confirm your connection. Make sure the nominal voltage, nominal
line frequency, and power type (delta, wye, other) are correct before you leave
the Recorder. It is a good practice to insert a Start Mark when you are finished
with all settings so you can download data and ignore useless readings and
events common at the beginning probe connecting activities. You can also use
the “Erase Memory” function.

Managing Recorded Data

Recorded data resides in the Recorder on an internal non-physically accessible
flash memory circuit. It is not transferred to a SD memory card in the
Recorder’s SD memory slot until you request a download action using the
PDA or an attached PC. Downloading to a PC running Fluke Power Analyze
Software (included) using the Ethernet cable is recommended and the fastest
way to retrieve data from the Recorder.

It is never technically necessary to erase internal memory. When the Recorder
has new data to record, it does so automatically, overwriting the oldest data.
You can erase internal memory for security reasons, or if you want to simplify
what you will be seeing in the download data dialog box. The start and end
times will represent one recording session when old data is erased.

Note

Data is not removed from internal Recorder memory until you erase it
using Power View software on the PDA or Power Analyze software
on your PC.

17
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Downloading Data and Erasing Memory

Use the Data menu options to manage the Recorder memory and download
recorded data to the SD card plugged into the Recorder’s (not the PDA) SD
card slot. You are downloading recorded data from the flash memory to an SD
card in the Recorder. When you want to use that data, you must move the card
data to a PC running Fluke Power Analyze Software. You can later copy the
data to your PC for review using the Power Analyze software. Tap
Menu/Data/1750 Internal Memory to view the Download screen.

245N

Orns 10ms 20ms Ei

L3 L1y 233.1 7
L2 233.8 ¥
L3 234.3 ¥
Ll i 0.5 v
1750 Internal Memory
1750 SO Memory

Erase 1750 Memory

Live |Menu| Y& [ <35 @

1750_Internal_Memory.bmp
The Download screen shows a three-phase rms V strip chart with date and
timescale shown. This represents the data in the Recorder internal memory.
The default settings of the start and stop times is everything in memory, to
download ALL, tap the Write to SD button.

The gray cursor lines right and left with triangular arrowheads at the bottom of
the screen show the start and stop times currently selected for download. Green
and red flags are START and STOP mark annotations inserted during the
recording session. Yellow flags are file name annotations inserted during the
recording session, or setup parameter changes that change the data
significantly, such as nominal voltage or power type.
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7 Power Yiew
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1750 IM Write to SD Card.BMP

If the SD storage card already contains data files, it may not have room for the
new download. Power View alerts you to this condition and asks if you would
like to erase the SD card before downloading.

1750 5D MEMORY cARD FILES €

Insufficient space Size:
423,73 | MB
Staored Files:
Filz Mame | Date | Size|~
Fluke-vienna_... 111970

Campus 21.odn 11/1970
Demo File.odn 1/1§1970
Fluke 1750.0dn  1/1/1970
4] ! 1]

Free space:

113328 | MB Delete File

I

azd107s.bmp

The Memory Card Full message appears for 5 seconds, followed by the screen
below. You can also access the download menu by selecting 1750 SD
Memory from the Data menu option.

You can delete files as necessary, and when satisfied that there is room on the

card, proceed to write the selected internal Recorder memory data to the SD
card.
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1750 SD MEMORY CARD FILES 69 (D

Staored Files:
Filz: Marne | Date | Size |~
Fluke-vienna_... 111970 286..

Campus 21.odn 1171970 2.4,
Demo File.odn 11f1970 15...|F
Fluke 1750.0dn  1f1/1970 35..,
Office.odn 1f1j1970  107..
Raytek Faciity.... 1711970 182,
Rectifier 2 aci... 111970 5S.0..[+]
4] ] [Tw
Free space:

11338 | MB Delete File

azd108s.bmp

When there is room on the card, a message confirming the download will
appear.

1730 <218= -

Downloading Data
Please wait...

Ll nc 0.
Data 0 ernal Memo

1750 1750 5D Memory
Exit Erase 1750 Memory

Live Menu LE in] @5 B

1750 IM Downloading Data.BMP

You can also tap the Erase 1750 Memory from the Data menu option which is
available under Menu, and tap the Erase All button to erase all power quality
data stored in the Recorder. Even then, if you want you can leave old data in
Recorder memory. It will be overwritten automatically when you start your
next Recorder session, so it never has an adverse effect on recorded data
quality or quantity.
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When you choose to Erase All, the following popup caution “Are you sure?”
appears on the screen.

Odin <211= -
ERASE 1750 MEMORY
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From . To:

H
=73 ] e
Live Menu Ea i) @ ?

erase_all.bmp
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Note

You can also download data by connecting your PC directly to the
Recorder with an Ethernet cable and run Power Analyze in the 1750
Live mode. All of the functions (controller, PDA, and Power View)
are duplicated in 1750 Live mode.

Power Type Diagrams

Power type diagrams are provided on Power View and Power Analyze and can
be referenced when you are setting up nominal power on the Recorder. The
diagrams are used an aid in making the correct test lead connections. The
following power type diagrams are for the standard power configurations:

e  One-Phase Plus Neutral

e  One-Phase IT No Neutral
e  One-Phase Split Phase

e  Three-Phase Wye

e  Three-Phase Delta

e Three-Phase IT

e  Three-Phase High Leg

e  Three-Phase Open Leg

e 2-Element Delta

e 2 '-Element Wye

Using Fluke Power Analyze

In addition to analyzing data that has already been recorded, you can also
connect to a Recorder through Power Analyze. When you do this, all of the
features available through the PDA are also available directly on your PC. For
example, you can:

e View live data by connecting to a Recorder connected to power.

e Configure a 1750 Power Recorder to which you are connected.
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Add annotation markers and take manual snapshots that are then
stored in the Recorder.

Fluke Power Analyze software lets you work on your PC with power quality
data monitored by and received from the Recorder. With Fluke Power
Analyze, you can download, review, and analyze data. For example, you can:

Download data from a Recorder into a data file on your PC, or open a
file that was downloaded previously and moved to your computer.

Analyze the data you have downloaded using a series of views to see
different aspects of it, including summary graphs of Volts/Amps/Hz,
events, harmonics, THD, flicker, power and energy.

As you review the data on the Power Analyze screens, you can adjust
the data shown by turning on and off display of different channels and
select other parameters. You can focus on the specifics that help you
analyze and understand the power quality data.

See snapshots of the recorded power quality data at specific points in
time as though you had looked at the measurements while they were
live.

Because snapshots are captured at regular intervals, you can advance
through them and review the measurement as they were at successive
points in time.

Build reports by tagging important data as you review it in Power
Analyze, and then use the Power Analyze Report Writer to gather it
into a report that includes images and details about the data.

This section of the Getting Started Guide describes how to begin working with
Power Analyze software to review and analyze data in recorded data files. Use
it to become familiar with the Power Analyze interface and features. Detailed
information for is available in the Power Analyze online help.

Getting Answers to Questions as You Work

As you work with Power Analyze, you can use Online Help to get detailed
information about how to use the software to examine recorded data, connect
to instruments and view live data, download data, and other tasks. You can
access the online help system included in Power Analyze in several different

ways.
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In the main window, click the Help question mark k2 on the toolbar and then

click an item on the screen to get information about that item. You can use this
to find information about buttons and other items on the toolbar, commands in
menus, and the main screens.

For information about the current view, or for help in a dialog box, click
Help | You can also see this information by pressing the F1 key.

You can also open the help system by choosing Help Topics from the Help
menu.

Once Help is open, you can use the Contents, Index, and Search tabs on the
left to help you locate information.

If the Help window is too wide, you can hide the navigation pane on the left by
clicking 2 at the top of the Help window. To open the navigation pane again,
click W.

Starting Power Analyze

You can start Power Analyze on your PC by choosing Start >All Programs
>Fluke >Power Analyze >Launch Power Analyze.

As you learn to use Power Analyze, you can use the file named
SAMPLE.ODN until you have a data file you want to analyze.

Note

You may need to copy the sample database SAMPLE.ODN from
where you installed the software (normally, c:\Program
Files\Fluke\Power Analyze) to the folder My Documents\PQ. You can
then use the File >Open command to open it. This problem can occur
if you do not have Windows Admin rights.

Working with Recorded Data Files

You work in the Fluke Power Analyze works with one file at time. When you
download data, it is stored in a file with the extension ".odn". When you
download using Power Analyze, these files are stored by default in the
directory “\MyDocuments\PQ\”. If you move downloaded data from the
Recorder to the PC via an SD card, you can copy the .odn file either to this PQ
directory or to another folder. For information about moving downloaded data
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to your PC, see “Moving Downloaded Data from the Recorder to a PC” later in
this manual

To start Fluke Power Analyze and open a file at the same time

1. In the Windows Explorer or on your desktop, locate the .odn file you
want to open.

2. Double-click the file to open the file in Fluke Power Analyze.
To open a data file when Fluke Power Analyze is already open
1. From the File menu, choose Open.

2. In the Open dialog box, navigate to the file you want to open, select it
and click Open.

The file opens in a Fluke Power Analyze window and displays the
Volts/Amps/Hz view. The name of the file appears in the application title bar.
For details about the Power Analyze window, see “Overview of the Power
Analyze Screen” later in this manual.

Moving Downloaded Data from the Recorder to
a PC

The procedure below describes how to download recorded data from the SD
card to your PC to analyze recorded data using Power Analyze.

To move the downloaded data from an SD card to your PC:

1. Download the data from the Recorder’s internal flash memory to the
SD storage card.

2.  Remove the SD storage card from the Recorder and insert into the top
of the PDA, for easy transport.

Place the PDA in a docking station connected to your PC.
The SD card should display as a drive in the My Computer folder.

On your PC, open the card as a drive.

S

Copy the files from the PDA to the desired location on your
computer.

You are now ready to open the recorded data files in Fluke Power Analyze.
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Overview of the Power Analyze Screen

Whether you are working with a recorded data file or are connected live to a
Recorder, many of the elements of the Fluke Power Analyze screen are the
same.

Power quality data appears in the central screen area. The type of data you see
depends on the active mode and view. Additional view controls on the right
side and buttons on the tool bar let you customize how the data displays.

Figure 3 shows the Volts/Amps/Hz recorded data view and Table 4 describes
the areas and controls of the screen. For a detailed review of the contents of the
actual data, see “Recorded Data Screen Overview” later in this manual.

0

BERIE

10 00umond]| | 0.
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Figure 3. Power Analyze Screen
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Table 4. Power Analyze Screen Areas and Controls

Number

Description

Connected Recorder. When you are connected to a 1750 Power
Recorder, this field shows its name. A drop-down list shows other
Recorders to which you can connect.

Name of data file. When you view recorded data, the name of the
".odn" file appears in the window title bar.

Help buttons. Several types of online help are available for Fluke
Power Analyze. Two are shown on this screen. For details about
accessing Help, see “Getting Answers to Questions as You Work”
earlier in this manual.

Main Data Area. The central part of the screen shows the power
quality data for the active mode and view. You can make further
adjustments to the data displayed by using the view controls and
tool bars.

View toolbar. Provides quick access to the different power quality
data views for the active mode (Recorded Data, Snapshots, or
Live 1750 Data). The active button on the View toolbar indicates
the view you see now.

View controls. View controls specify what data to display in the
view, and how it should appear.

Status Bar. Shows the power configuration, nominal voltage, and
frequency for the data you are viewing. When viewing live data, it
also shows the name of the Recorder.

Power Analyze Mode Side Bar. Mode buttons activate different
sets of views and screens in Power Analyze. The active button
indicates the mode in view. In the screenshot example, View
Recorded is active. For more information, see “Overview of the
Power Analyze Modes” later in this manual.

Main tool bar. Frequently used actions appear as buttons on the
toolbar.

Menu bar. Menus provide access to Power Analyze commands.
Frequently used menu items are also available on the main
toolbar and view toolbars.
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Overview of the Power Analyze Modes

There are six modes in Fluke Power Analyze, all available
from the side bar at the left of the screen. The top three
allow you to work with recorded data that has been saved as
a data file, while the bottom three let you work with live
data when you are connected to a Recorder.

Recorded Data Modes

These modes are available when a recorded data file (.odn)

YYiew Recorded

Yiew Snapshots

is open.

e View Recorded lets you analyze data that has been
downloaded from a Recorder and saved as a data
file.

B

View Setbings

e View Snapshots displays snapshots of measured
power conditions taken manually or on a periodic
basis throughout the monitoring period and stored

A= fn
‘4
. -:\__!

1750 Setup

in the recorded data file.

e  View Settings displays the Recorder settings that
were in effect when the recording was made. This
includes power configuration, nominal voltage and

1750 Live

frequency, voltage and current ratios, and other
connection factors.

)

1750 Downloa

Live Data Modes

bae106s.bmp

These modes are available when connected to a Power Recorder.

e 1750 Setup lets you view and set the instrument settings, including
the power configuration, nominal voltage and frequency, voltage and
current ratios, and other details about the data that is recorded before
starting a recording session. You can also create a password in this

mode.

e 1750 Live lets you monitor data directly, when you are
Recorder.
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e 1750 Download lets you retrieve data from the Recorder and save it
on your computer.

Recorded Data Screen Overview

Recorded data views are the primary screens you work with when analyzing
power quality data. Five different views of recorded data are available:
Volts/Amps/Hz, Events, Harmonics, THD, Flicker, EN50160, and
Power/Energy. Figure 4 shows a sample Recorded Data Screen and Table 5
describes the contents of the screen.

In many of the recorded data views you see both a Reference graph and a
Detail graph. When zoomed out, the reference graph shows the full range of
available data. The detail graph shows a subset of that data. For more
information about the screen menu and buttons, refer to the section “Overview
of the Power Analyze Screen” earlier in this manual.

When you work with recorded data, many of the elements on the screen are the
same regardless of which view is displayed.

Note
Check the Fluke website (www.fluke.com) for updates.
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Recorded Data Screen Overview

Table 5. Recorded Data Screen Contents

Number

Description

Name of open data file. Shows the name of data file that is
presently open.

Reference graph. Provides an overview of the data for the entire
recorded period.

Detail graph. Shows a detailed view of a portion of the recorded
data, determined by the selection cursors on the top graph.

® @ ©

Selection cursors. The selection cursor bars mark the data
shown in the Detail graph. As you move the cursor bars, the data
in the detail graph adjusts.

View toolbar. Lets you change between recorded data views. The
active button indicates the view you see now. In the screenshot
above, Volts/Amps/Hz is the active view.

View controls. Specify data to be displayed in the view, and how
it should appear. For example, on the Volts/Amps/Hz graph shown
above, view controls let you hide or show phases, select whether
maximum values are shown, or show or hide annotations.

Status Bar. Shows the power configuration, nominal voltage, and
frequency for the data you are viewing.

Measurement guides. This set of guides let you measure data in
the Detail graph. The measurement value is shown on the boxed
labels between the guides.

Graph toolbars. Provide access to tools you can use with graphs,
such as showing and hiding the guides, or zooming in on data.
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1750 Live View Screen Overview

When you are connected to a Recorder, five different views of the live power
conditions are available. You can see this same information using Fluke Power
View on the PDA. Figure 5 shows a sample Live View Screen and Table 6
describes the contents of the screen.

Although the format of the 1750 Live views vary, the overall structure of the
live screens is the same. The screenshot below shows the essential elements in
the live Scope view. For more information about the Scope view and other
1750 Live views, see the Online Help.
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Figure 5. Live View Screen
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Table 6. Live View Screen Contents

Number Description

® Connected recorder. Shows the name of the Recorder to which
you are connected.

® View toolbar. Lets you change between live views. The active
button indicates the view you see now. In the screenshot above,
Scope is active.

® Main data area. Displays the power quality parameters you are
viewing: Scope, PHASOR diagram, meter, harmonics, or power.

® Status bar. Shows the Recorder setup, including selected
Recorder name, IP address, power configuration, nominal voltage,
and frequency. You can set this information using the 1750 Setup
mode, or using Power View on the PDA. For more information
setting up a Recorder through Power Analyze, see the Online
Help.

® View controls. Specify what data to display in the view, and how
it should appear.

Snapshot Screen Overview

Snapshots are screen captures at a single point in time of the measurements
made by the Recorder as displayed in 1750 Live mode. When you download
data, you download snapshots (taken manually and at regular intervals), along
with the long-term summary data and events. All five views that are available
for live power are also available in the snapshot views, giving you a detailed
view of conditions at specific intervals.

When you first display the Snapshot views, you see the first snapshot taken in
the downloaded data. You can use the Slider Bar or the Next/Previous buttons
to bring additional snapshots into view.

The interval at which snapshots are captured is specified when the Recorder is
set up. In addition, a snapshot can be taken manually using the PDA or using
the Take Snapshot button.

Figure 6 shows the main elements in snapshot views. More detail on specific
snapshot screen elements are described in Table 7.
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Figure 6. Snapshot Screen

Table 7. Snapshot Screen Contents

Number

Description

Data filename. Shows the name of the data file presently open.

Slider bar. Allows you to move to a snapshot at a different point in
time within the recorded data by dragging the slider.

Main data area. Displays a snapshot of the conditions at the date
and time shown in slider bar. In this example, the snapshot is of
the Scope for the phases checked in the Phase Selection area of
the view controls. For details about the contents of the different
snapshot views, see the Online Help.

View toolbar. Lets you change to different Snapshot views:
Scope, Phasor, Meter, Harmonics, and Power. The active button
indicates the view you see now.
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Table 7. Snapshot Screen Contents (cont.)

Number Description

® Next/Previous buttons. Lets you move through snapshots one at
a time by clicking these buttons.

(6 View controls. Specify data to be displayed in the view, and how
it should appear.

@ Status bar. Shows the power configuration settings at the time the
data was recorded.

Working with Snapshots

Snapshots are captured at regular intervals, based on the Snapshot Interval set
in 1750 Setup. You can also capture snapshots manually using the Take
Snapshet button on the Power Analyze toolbar in 1750 Live Mode, or using
the wireless PDA with the Recorder. Snapshot data is saved in the Recorder
and downloaded with the rest of recorded data.

When viewing at Snapshot screens in Power Analyze, two tools are available
to move through the available snapshots:

e The Slider bar appears at the top of each Snapshot view.

Press and drag the cursor to move to another snapshot
'E?fm/uwmm} : ] : : : : ]

: i i d d |
07/01/04 500:00 07/01/04 12:00:00 07/01/04 16:00:00 07/01/04 20:00:00 07/02/04 0:00:00 07/02/04 40000

bae044s.bmp

Press and drag the slider bar to the point in time for which you want
to see power conditions.

The snapshot data closest to this point in time is shown in the
Snapshot view.

e The Next/Previous buttons (_< | * |) appear at the top of the View
controls.

Click these buttons to move to the next snapshot in either direction.
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Main Toolbar

The main toolbar in the Power Analyze window includes standard Windows
tools and some specialized buttons for working with Fluke Power Analyze
graphs. Figure 7 shows the Main Toolbar and Table 8 describes the contents of
the toolbar.

Hide or show the toolbar by choosing View >Toolbar.

Note

The tools on the main toolbar all have a corresponding topic on a
menu.

File Edit Mew Tools Window Help
= bW - = o | B 7 K2 ||[voltamps:1 -

bae017s.bmp

Figure 7. Main Toolbar

Table 8. Main Toolbar Contents

Button Description

= | Open. Opens a recorded data file.

™ Top Full Screen View. Expands the top graph to fill the graph
window area.

Bottom Full Screen View. Expands the lower graph to fill the
graph window area.

ol

- Split Screen View. Displays a reference graph on the top and a
details graph in the bottom of the graph window area.

= Top Table View. Toggles the display of the data in the top
reference graph from graph to table and then back.

Bottom Table View. Toggles the display of the data in the bottom
detail graph from graph to table and then back.

36



1750 Power Recorder
Graph Toolbars

Table 8. Main Toolbar Contents (cont.)

Button Description
Take Snapshot. Takes a snapshot of the current
& power measurements. Available only in 1750
Live views.
H Insert Annotation. Inserts an annotation

marker. Available only in 1750 Live views

Help. Lets you get information about buttons on
the screen and commands in the menus. Click
the Help tool button and then the item you want
information about. For information about the
contents of the main graph area, click the Help
button at the top of the Graph controls on the
right side.

|‘I.r'ulthmps:1

[

Window List. Lets you switch between multiple
windows in the same recorded data file.

Graph Toolbars

When you view data on graphs, special toolbars are available to help you work
with that data. Figure 8 shows a sample Graph Toolbar and Table 5 describes
the contents of the toolbar.

The particular tools available vary depending on the contents of the graph. The
screenshot below shows some of the tools that appear on graph toolbars, and
more detailed information about specific features follows that.

bae105s.bmp

Figure 8. Graph Toolbar
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Table 9. Graph Toolbar Contents

Button Description

ﬂ Zoom All the Way Out. Zooms out to display the full graph.
Active only after you have zoomed in on a portion of a graph.

Zoom Out. Zooms out on the graph keeping the same graph
center.

Select. Lets you select annotation markers in graphs on the
Volts/Amps/Hz view and the Events view. When you select this
tool Zoom becomes inactive.

@ Zoom In. Zooms in on the graph keeping the same graph center.

Guide. Shows or Hides the guides on a graph.

Copy. Copies the current graph to the Clipboard.

Zooming In and Out On Graphs

Sometimes the amount of data shown on a graph makes it hard to clearly see
the detail you need to analyze power quality data. When this is the case, you
can zoom the graph to magnify your view of the data. A combination of
zooming and scrolling can often be used to focus on the specific information
you need.

Several zooming tools are available: the Zoom Box and Zoom In/Zoom Out
buttons on the graph toolbar, and the Zoom to Fit command on the right-click
menu (available when you point to either the horizontal or vertical axis).

To zoom in and out incrementally:
e In the graph toolbar, click @ and g

To zoom in on a section of a graph with the Zoom box:

1. Ifitis not already active, click
2. Draw over the section of the graph you want to see in more detail.

Fluke Power Analyze zooms in on the area you marked and centers it
in the window.
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The selection cursors on the Reference Graph shift to mark the new
selection.

If the information you want is not quite centered, you can scroll the
graph horizontally or vertically.

Note

You can zoom in multiple times on an area of a graph. If the graph
area appears blank, you may have zoomed outside the range of data.

To zoom out

If you want to zoom out incrementally, click @
If you want to zoom back to 100 % size, click ﬂ

To use Zoom to Fit:

You can automatically zoom the available data to the size of the graph window
by using Zoom to Fit.

You can Zoom to Fit based on either the Y-axis or the X-axis:

1.
2.

Right-click on the axis you want to resize.
Choose Zoom to Fit from the right-click menu.

The available data zooms to the size of the window, based on the axis
where you right-clicked. If appropriate, the axis will adjust to match
the range of data.

In the Harmonics and THD views, using Zoom to Fit on the x-axis of
the Harmonics Spectrum graph will display all 50 harmonics in the
graph window at once.
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Screen View Tools

When you first view recorded data, the views show two types of data in a split
view format. Figure 9 shows a sample Screen View Tools and Table 10
describes the tools.

For most views, the data includes reference data, which gives a broad view of
the recorded data, and detail data in the display’s top half, which appears in the
bottom half of the display.

Options on the left toolbar let you expand either set of data to fill the window.

Note

This feature also works when you are displaying as a table either the
top or bottom set of data.

bae025s.bmp
Figure 9. Screen View Tools

Table 10. Screen View Tools

Button Description
ot Click to see the top full screen view.
[ Click to see the bottom full screen view.
-~ Click to see both graphs again.

Viewing Data as a Table

In most recorded data views, you can view data in table format as well as in
graph format. This is useful for studying results in the form of digital readings,
or preparing tabular data for a report.

When you switch to the table display, the tables generated remain on the
screen even as you change recorded data views, until you turn off the table
display and switch back to graphs.
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Note

If you click the Tag for Report button when a table is in view, the
portion of the table in view will be included in your next report. (For
more information, see “Building a Report” later in this manual.) To
print all of the data in the table, first export it to a spreadsheet.

To toggle between graph and table views:

You can toggle between graph and table views for the top graph, the bottom
graph, or both graphs.

e  Click one of the Table tools = = to display the upper or lower
graph as a table.

e  Click the Table tool again to return to the graph display shown in
Figure 10.

W RUS i‘
Lin LN Lan
Hin Avg Max Min Avg Mex in Avg Max
27.10.2008 12.36:51 602 232,03 2242 23274 23213 w5 2282 2242 23271 21256
27.10.2009 12.39:59.882 232,03 23242 232,74 232,18 2325 23282 23,82 23271 23298
27.10.2008 12.48:58.673 230,72 232,60 233,04 231,20 2257 23280 231,55 2282 23320
27.10.2009 1259:59.930 a8 23265 23419 232,07 23264 2342 23229 232,88 23448
27.10.2008 13:08:58.625 23248 23521 234,41 23261 2338 234,85 23283 233,61 23478
27.10.2009 13:19:59.988 23273 233,10 233,33 23275 23312 23341 23289 23331 23362
27.10.2008 13:28:50.658 232,48 23328 23367 232,10 23308 23359 2262 23373 23423
27.10.2009 13:39:59.936 2330 23352 233,80 232,13 2328 23368 233,48 233,85 23417
27.10.2008 13.48:50.678 Fox) 23389 234,08 23289 23349 23385 23322 23404 23439
27.10.2009 13.59:50.693 233,14 23354 23444 23207 23277 23444 233,40 233,90 23504
27.10.2009 14:09:59.807 232,74 23388 23499 232,73 23355 234,93 233,08 23405 23542
27.10.2009 14.19:59.648 2282 23337 23368 23287 23332 233,74 23330 23372 23406
27.10.2009 14:29:59.928 272 23328 23367 232,83 233,18 23352 233,10 23355 23402
27.10.2009 14:39:59.671 23262 23299 23337 23269 23303 23347 23283 233,41 23367
27.10.2009 14.49:59.893 232,45 233,07 23386 232,53 mm 23350 23287 23335 23384
27.10.2009 1459.50.671 23260 23,16 23358 8 23303 23345 23290 233,55 23403 =

bae027s.bmp

Figure 10. Graph Display

To sort the data in a table:

e When you view Events in a table, you can sort the tables by clicking
the header for the column you want to sort by.

To maximize a table to full size:

e Click the Top Full View button or the Bottom Full View button
(cH %), depending on which table you want to view full size.
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Working with Annotations

Annotations are optional markers that can be inserted by the Recorder operator
to flag a particular point in the data when recording. They are usually inserted
on using Power View with the wireless PDA. Figure 11 shows a sample

Annotation View screen.

Annotations can be used to help select what data to download, and to provide
additional information when reviewing recorded data in the Volts/Amps/Hz

VIEW.
Recorded Volts/Amps/Hz Zoomed Detail: 27.10.2009 13:43:36 - 29.10.2009 23:48:23
220 p
2004~
""" | |
2304~
,,,,, | 4 n | | |
23604+ | Ml
..... g7 [N W " I
234040 ! e ¥ f\ 1A M 1 he¥
Mg P { v
P 2321 ! | i {
> 230,398V AMS 1 !
230 03,1028 22:34.41 355

([33.574° AMS

280810 27 1343 38 431

226/

224

2221

220

DD.MM.YY HH:MM:SS

28100900000 281003120000 231003 0.0000

2310.03 120000

Figure 11. Annotation View

There are five types of annotations:

e  Start annotation (green)

bae063s.bmp

The Start annotation can be used to signify where important data
begins. For example, the operator might want to establish a start
annotation after having finished all probe connections and instrument

setup, to indicate that any preceding data was preliminary.

Note

You are not limited to using the Start and Stop annotations in pairs,

or to show a range of data. You can use each as many times as

desired to mark a particular point during recording.

e Stop annotation (red)
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The Stop annotation can be used to signify where important data
ends.

File annotation (yellow)

File annotations contain the name of a picture or audio file relevant to
the data. See “Using Image or Voice Annotations” later in this
manual.

Text annotation T
Text annotations contain a text note.
Power Configuration Change annotation *

Power Configuration Change annotations are inserted by the system
when a change is made to the Power Configuration in the Recorder.
These markers only display in the Download dialog box.

To show or hide annotation markers

In the Volts/Amps/Hz or Events view, check or uncheck the
Annotations option on the view controls.

To open an annotation

In the Volts/Amps/Hz view, Events view, or Download dialog box,
click on the annotation.

If the annotation is associated with an audio (.WAV) or image (.jpg)
file, the application associated with that file will start and open the
file. If the file is not in the default directory My Documents\PQ, a
dialog box opens so that you can navigate to the file.

Note

If clicking on an annotation marker does not seem to do anything, the
Zoom box is probably selected in the graph toolbar, instead of the
Select tool. Click the Select tool and then select the annotation.

To see overlapping annotations

Sometimes annotations are so close to each other that they actually overlap on
the Volts/Amps/Hz reference graph. When this is the case, if you click on
overlapping annotations, a menu opens and you can select either Open, to open
the annotation now on top, or Select Next Overlapping Annotation, to bring
the next one to the top.
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e To open the annotation now on top, choose Open.

e To bring the next annotation to the top, choose Select Next
Overlapping Annotation. To then open that annotation, click on it
again and choose Open.

Note

To see overlapping annotations more clearly on the Volts/Amps/Hz
reference graph, move the selection cursors so that they just surround
the area that contains the overlapping illustrations. The Detail graph
adjusts as the cursors move, zooming in to show the area between the
selection cursors. You can now see the annotations separately.

Using Image or Voice Annotations

While you are monitoring data with a Recorder, you may find it helpful to take
a picture that relates to the power quality data you are recording, or to record
verbal comments as you observe the conditions or review the data being
measured. You can then associate the image or recording with the data being
recorded by adding annotations that reference them.

The PDA includes a microphone for recording notes which are saved as WAV
files, and an optional camera accessory is available on the PDA which will
capture images as .jpg files.

You can associate both images and audio files with the data being gathered in
the Recorder by inserting annotations and specifying the name of a . WAV or
.jpg file. After you download data from the Recorder, you can then move the
image and audio files to the PC along with the recorded data (.odn) file.

Note

You can also associate other types of files with the annotation. For
example, if you had a .MPJ file with a movie, or a .DOC file with
associated information. You can enter any file name using this
annotation method.

Inserting Image or Voice Annotations

1. Setup the Recorder and begin monitoring.
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Using your PDA-cam or another camera, take a picture of what you
want to capture.

In Power Analyze, go to 1750 Live mode and click B to open the
Annotate dialog box.

Or on your PDA, in Power View, click the Annotate icon to display
the Annotate screen.

Select Insert File.

Browse to find the picture file (for example, IMG_2435.jpg ) or audio
file (for example, voice 123.wav) and select it; then click Insert.

The file name you specified is inserted into the data and associated
with the present date and time (and therefore, the present power
measurements).

Managing Image and Voice Files

If you are using the PDA, move the image or audio file to a location that will
make it easier to Transfer it to a PC later, when you download and move the
recorded data file to your PC. You can accomplish this in two ways:

Place the file into the synchronization folder on your PDA, so that it
will be automatically transferred into the sync folder on the PC the
next time you dock the PDA.

You may find this approach useful if you download data using Power
Analyze on your PC. After synching the files from your PDA, be sure
to move the annotation files into the folder that contains your .odn
files (by default, \My Documents\PQ).

Transfer the file onto an SD card for later transfer to your PC.

If you use the PDA to download data to an SD card, copying the
audio or image files to the SD card may be the easiest method; then
you can copy all associated files to your PC at once. Be sure to copy
the files into the same folder that contains the downloaded .odn file.

Building a Report

You can build a report by tagging specific data you see on the screen in the
View Recorded and Snapshot modes. You can tag as many different views as
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you want before creating the report. Power Analyze remembers what you have
tagged until you exit the application, or until you generate a report. If you tag
more than you need, it is easy to delete tagged items from the report later.

Note

To make use of the reporting feature in Power Analyze, you must have
Microsoft Word 2000 or later installed on your computer.

To include data in a report
1. Get the screen to look just the way you want.

Power Analyze will capture the contents of the main area just as you
see it. Use any of the tools — view controls, zoom features, split/full
screen, and so forth — to adjust the display.

2. Click the Tag for Report button at the bottom of the view controls.
3. In the dialog box that displays, enter a heading to identify the data.

This heading will appear in your report. By default, Power Analyze
inserts the name of the active view. You can change this heading to
be more specific.

4. Click OK.

5. Continue working, tagging additional screens when you want to
include them.

To create the report
1. When you are ready to create the report, choose File>Report Writer.
A dialog box lists the items you have tagged.
2. Enter a name for the report and click OK.

If you want to create the report in a particular location, before you
click OK, click the Browse button, navigate to the appropriate folder,
and click Open.

After you click OK, Microsoft Word opens, displaying the screens
you tagged. In addition, details about the data are included, such as
what channels and phases are displayed, and other criteria selected
with the View controls.
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Note

To append to an existing report, click Browse and select the report
file to which you want to append. The new data you have tagged will
be added to the end of the existing report file. (The existing report file
must be closed when you select it; it cannot already be open.

3. You can add additional information to the Word document, to

customize your report.

205 Westwood Ave
Long Branch, NJ 07740
1-877-742-TEST (8378)

Fax: (732) 222-7088

salesteam@Tequipment.NET

equipment =
h p.NET )
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